PowerSchool SIS: PowerTeacher Pro

To navigate to the gradebook:

PowerSchool's PowerTeacher Pro gradebook is a robust classroom
management tool that includes advanced features for both
standards-based and traditional grading. Teachers use the mobilefriendly gradebook to get their work done and to analyze student
performance.

1. Enter the URL of the PowerSchool SIS server followed by
/teachers
2. Enter your username and password
3. Click Sign In
4. On the PowerTeacher Start Page, click PowerTeacher Pro
5. Read the welcome message and click Close
To view the message again, click the Help icon and select
Getting Started. Also click the Help icon to access the
PowerTeacher Pro Help system, and information about new
features.

Accessing the Gradebook
Teachers navigate to the HTML-based gradebook directly through
the teacher portal. There’s no need to launch a separate
application to access the gradebook. The first time you navigate to
the gradebook, you’ll see a welcome message that introduces some
of the features.
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7. Click the arrow to the left of another class name to open the
details pane and add a custom name or description

Customizing Class Names and Adding
Class Descriptions
The gradebook includes view-only details about each class you
teach, such as the course name, course number, section number,
period, term, start date, end date, and associated grade scale. Add
more details about the class, such as a description or the syllabus,
that will be visible in the PowerSchool SIS Student and Parent
Portals, and in PowerSchool Mobile.
Also customize the name of the class if you prefer to use a name
that is different from the course name. For example, if you teach
multiple Biology classes, customize the names to be different from
each other. Custom class names will appear only in your
gradebook. Co-teachers, students, and parents will not see them.

8. Click Save

Setting Up Display Preferences
Customize the display settings to control how class names appear
in your gradebook—by period and day or by section number.
Additionally, define whether or not to show standards and
traditional grades.
To set up display preferences:

To customize a class name and add a description:
1. At the top of the gradebook window, select a class
2. In the upper-right corner, select the term in which the class
meets, if different from the current term, or select all terms
3. Click Settings
4. Select Class Descriptions
The details pane for the selected class opens.
5. To customize the name of the class, enter the name in the
Custom Class Name field
Once you click Save, the custom class name will appear in
the gradebook automatically.
6. Enter the class description, syllabus, or other details in the
Class Description field
Use the editing bar to style the description.
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1. Click Settings
2. Select Display Settings
3. Open the "Display and Sorting" menu and select an option,
such as Section Number (sort by Course/Custom
Name), to change the way class names appear
When you choose to sort class names by course name or
custom name, classes will be sorted by their course names,
unless you've entered custom class names on the Class
Descriptions page. In that case, classes will be sorted by
their custom names.
4. Check Show Traditional Grades to display traditional
grades in the gradebook
5. Then from the “Values to Show in the Traditional Grade
Column” menu, select the types of grades you want to see,
such as Grade, Percent, and Points
6. Check Show Standards Pages and Links to use the
standards grading features in the gradebook
7. Check Show Standards on Assignments to show
standards aligned to assignments in the gradebook
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8. To make the auto-calculation of standards scores from
assignments scores the default setting when you create a
new assignment, choose New Assignments Start
Checked from the “Auto-Calculate Assignment Standards
Scores Initial State” menu
Making this selection will cause the “Auto-Calculate
Assignments Standards Scores” check box to be selected by
default when you create an assignment. To view the setting
when creating a new assignment and navigate to the
Standards tab.
9. To change the sort order of the Traditional and Standards
navigation links in the Grading menu and Quick Menu, open
the Navigation Links Sort Order menu and choose
Standards, Traditional
The default setting is Traditional, Standards.
10. To display the Professional Judgment Indicator on the
Standards, Standards Progress, and Standards Scoresheet
pages, check Show on Grading (Standards Final
Grades) and Show on Students (Standards Progress,
Standards Scoresheet)
11. Under Student Names, use the Display menu to define how
students’ names will appear in the gradebook, such as by
first, then last name
12. Use the “Sort Students by” menu to choose how to sort the
lists of students, such as by first name
13. To view new students’ names at the bottom of class lists,
check Add newly enrolled students to the bottom
14. To conceal the names of pre-registered students from class
lists, check Hide pre-registered students

Changing the Display Text Size
PowerTeacher Pro is designed so that you can see multiple
students or assignments in a compact view by default. However,
you can zoom in by changing the text size.
To change the size of the text:
1. Click the User menu in the upper-right corner
2. Under View, select Medium or Large
To decrease the text size to the default size, select Small.

Setting Up Grading Preferences
Administrators may choose to set up the grading preferences at
the district or school level for all teachers. However, if they are
permitted to do so by their district and school leaders, teachers
may define some of the grade calculations for the classes they
teach. Provided you have permission to do so, set up the grade
calculations for one class. Then save time by copying the
traditional grade calculations across classes and reporting terms.
If you changed the default grade calculation formula set by the
school or district, you can revert back to the default settings by
clicking Revert to Default in the class heading. If you do not see
the button, that means you have not modified the default settings.
Additionally, administrators may make alternate grade scales
available for teachers and administrators to assign to individual
students. If you have permission to do so, assign alternate grade
scales to students who need to be graded using a grade scale
that's different from the scale assigned to the class. For example, a
student may have an IEP that specifies the use of an alternate
grade scale.

15. Click Save
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If administrators have given you permission to create or modify
class grade scales, you may also edit the grade scales used by all
of the students in one or more of your classes.

13. Repeat steps 9-12 to set up weighting for two more
categories
Use weight values that will make the values in the Percent
columns add up to 100%.

Traditional Grade Calculations

14. To save the grade calculation, click Save

To define a traditional grade calculation for a class:

Set up the grade calculations for the remaining reporting
terms. If you do not have access to edit the grade
calculation preferences, follow your school and district
policies or contact your PowerSchool SIS administrator.

1. Click Settings
2. Select Traditional Grade Calculations
3. To see the grade calculations for all of the classes, click
Expand All
4. For one of the classes in the list, click the Edit icon next to
the first reporting term

To define a traditional grade calculation that includes specific
weighting for course standards:

5. To calculate the overall class grade using the formula, verify
that Calculate Overall Class Grade is checked
6. Open the Type menu and choose a calculation type, such as
Category Weighting
7. Open the Attribute menu and select a category, such as
Homework
8. To define the weight of the selected category, enter a value
in the Weight field, such as 2 (for 20%)

1. Click Settings
2. Select Traditional Grade Calculations
3. To see the grade calculations for all of the classes, click
Expand All
4. For one of the classes in the list, click the Edit icon next to
the first reporting term
5. To calculate the overall class grade using the formula, verify
that Calculate Overall Class Grade is checked

9. To include another category, click the + sign

6. Open the Type menu and choose Standards Weighting as
the calculation type

10. Open the Type menu and choose Category Weighting

7. From the Attribute menu, choose Specific Weights

11. Open the Attribute menu and select a different category,
such as Quiz

8. Click the Specific Weights tab

12. To define the weight of the selected category, enter a value
in the Weight field, such as 3 (for 30%)
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9. If your school or district leaders have enabled editing rights
for you, modify the values in the Weight column to change
the weight of course standards

2. Select Traditional Grade Calculations
3. In the upper-right corner of the Traditional Grade
Calculations page, click the gear icon
4. Select Copy Traditional Grade Calculations

If you have not been given permission to edit the weights,
you will be able to only view the specific weights set for the
course at the district level.

5. At the top of the Copy Final Grade Calculations window,
select Within A Class to copy the settings from one
reporting term to another within the same class

10. To save the changes, click Save

6. In the From area, open the Class menu and choose the
class from which you want to copy the calculations

Standards Grade Calculations

7. In the From area, open the Reporting Term menu and
choose S1 as the term from which you want to copy the
calculations

To define standards grade calculations:
1. Click Settings
2. Select Standards Grade Calculations

8. In the To area, open the Reporting Term menu and choose
S2 as the term to which you want to copy the calculations

3. Define how standards grades will be calculated from
assignment scores by default, for example, choose Most
Recent Scores

If you are changing traditional grade calculation settings for
the target class and want to recalculate any existing grades,
check Recalculate Final Grades.

4. Define the number of recent scores to include in the
calculation and their relative weighting by clicking the Edit
icon, choosing the number of scores, and modifying the
values in the Weight column

9. Click Validate
10. Review the summary to ensure that you are copying the
correct settings, then click Copy

5. To automatically calculate higher-level standards grades
from lowest-level standards grades, check Auto-Calculate

The alert at the top of the window indicates that the
settings were copied successfully.

6. Select the metric that will be used in the calculation, such
as Mean
7. Click Save

Copying Traditional Grade Calculations

Reverting to Default Calculation Settings
To revert to the district or school default settings:

To copy traditional final grade calculations:
1. Click Settings
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1. Click Settings
2. Select Traditional Grade Calculations or Standards
Grade Calculations
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3. In the class heading(s), click Revert to Default

9. On the Student Grade scales page, view, modify, or remove
grade scales assigned to individual students
Note: When a student has been assigned an alternate grade
scale, the Scoresheet will include a gold triangle in the
name cell for that student.

The Revert to Default button will not be visible after you
revert to the default settings.

Assigning an Alternate Grade Scale to a
Student
To assign an alternate grade scale to an individual student:
1. Click Settings

Creating and Modifying Class Grade Scales

2. Click Student Grade Scales

District or school administrators may give teachers permission to
modify existing class grade scales or to create new ones for their
classes. This provides the flexibility to accommodate various
grading policies and is similar to functionality in a legacy
PowerSchool product, PowerTeacher Gradebook.

3. Locate the section the student is enrolled in and click the
arrow next to the section name
4. To add a student grade scale, click Add
5. From the Choose Grade Scale menu, select the alternate
grade scale
6. Check the box to the right of the student's name
7. Click Save
8. To confirm the change, click Save Changes
New assignment scores that you enter for the student will
be based on the alternate scale. To update previously
entered scores, recalculate final grades by following the
steps for recalculating final grades in this document.

If you choose to use the Class Grade Scale feature, it should be
part of the setup at the beginning of the school year before class
begins and before grades are entered. PowerSchool strongly
recommends that this feature is not enabled or changed during the
school year.
If you have permission to do so, you can access and adjust class
grade scales for your classes. You can edit the cutoff points, grade
values, and color levels, and choose to ignore specific grades in the
grade scales assigned to your classes.
To create a custom grade scale:
1. Click Settings
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2. Click Class Grade Scales
Click the arrow to the left of a class grade scale name to
open the details pane.
The Class Grade Scales page provides a user-friendly
summary to view the grade scales assigned to classes, even
when the custom grade scales feature is not used or
enabled.
3. Click Create Custom

Note that if you change or modify the class grade scale settings
after grades are entered, you will be prompted with the option to
recalculate the final grades for applicable classes. If you delete the
custom grade scale after grades are entered, the deletion will force
a recalculation of assignment scores and final grades for the
associated sections and you will be prompted with a choice to
proceed or not.
Here are some additional points to keep in mind when using class
grade scales:

This option is available only if enabled and the feature is not
locked as shown by the school building icon and the term is
not locked as indicated by the lock icon.
4. In the Custom Grade Scale window, enter a name for the
custom grade scale and select the available classes to apply
this custom grade scale
5. Click Create
The new grade scale will appear below the existing grade
scale.
6. Scroll down to the new grade scale and edit the cutoff and
grade values, color levels, or choose grades to ignore
7. Click Save
After you create a custom grade scale, you can modify it by
clicking Modify. You can change the name of the custom grade
scale, apply it to more classes, delete it, or modify the cutoff and
grade values, color levels, and ignored grades. Then click Save.

•

Co-teachers can create class grade scales for their classes if
they have edit access to the classes

•

Class grade scales do not roll over year to year

•

Only one class grade scale can be associated with a class

Working with Assignments
Before you begin creating assignments, it’s recommended that you
create categories so you can group assignments by type. Then, set
up assignments in the gradebook, choose whether or not to include
them in students' final grades, and tie them to standards. Your
district leaders may also set up assignment categories at the
district level for you and other teachers to use.

Creating Categories
Categories are broad classifications in which you group similar
types of assignments. Examples of categories are homework, tests,
and quizzes. Set up your own categories, or use district-created
categories. District-created categories are identified by an icon that
looks like a school house next to the category name.
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12. To include extra points in the assignments by default, click
Extra Points and enter the number of extra points, such as
5
13. To weight assignments in this category by default, click
Weight and enter a value, such as 2, in the Weight field
14. In the Score Entry Points field, enter the number of points
that assignments in this category will be worth by default,
such as 100

To create an assignment category:

15. To include assignments in this category in final grade
calculations by default, verify that Count in Traditional
Final Grade is selected

1. Click the Create icon
2. Select Category
3. On the Category tab, open the Select Classes menu and
select the class or classes in which you will use the category
By default, the category is available to all classes.
4. Enter the name of the category, such as Test
5. Select a color for the category, such as Red
6. Use the default status of Active
Check Inactive when you want to make categories that you
no longer use inactive.

16. To save the new category, click Save

Creating and Viewing Assignments
View assignments on both the Assignments and Scoresheet pages.
Set up assignments at the beginning of a school term or at any
time during the term. To save time, duplicate existing assignments
or create duplicates while creating a new assignment.
To create an assignment:

7. Enter a description of the category, such as Use for test
assignments
8. Click the Assignment Defaults tab
9. Use the Publish Assignment menu to define when
assignments in this category will be published
10. To publish the scores of assignments in this category by
default, verify that Publish Scores is selected
11. Select the default score type that assignments in this
category will use, such as Points
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1. Click the Create icon
2. Select Assignment
3. Open the Select Classes menu and select a class
Click outside the Select Classes menu to close it.
4. Enter the name of the assignment, such as Unit 1 Test
5. Select Test as the category
6. Enter the assignment due date
The default due date is today’s date.
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7. Select a score type, such as Points

To edit an assignment:

8. Enter the number of score entry points, such as 80

1. Click Grading and select Assignment List

9. To include the assignment in students’ final grades, verify
that Count in Traditional Final Grade is selected

2. Locate the assignment and click the Edit icon

10. Enter a description, such as This test covers all of the
topics in Unit 1

3. Modify the assignment details and save the assignment
To duplicate an assignment for use in another class:

11. Click the Students tab
12. Verify that the assignment applies to all students
To apply the assignment to a selection of students, click
Show All. Then clear the check box next to the Filter area
and check the boxes next to the selected students’ names.
13. Click the Standards tab
14. Select the standards that are aligned to the assignment
15. Click the Publish tab
16. Open the Publish Assignment menu and choose when to
publish the assignment for students and parents
17. To publish students’ scores once you’ve scored the
assignment, check Publish Scores
18. Click Save and Close at the bottom of the Create window
Instead of closing the edit window, you could also copy the
assignment by clicking Duplicate at the bottom of the
Create window.
Score the new assignment immediately by clicking Score
Assignment in the alert at the top of the window.
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1. Click Grading
2. Select Assignment List
3. In the list of assignments, locate an assignment that you’ve
already created and click the Edit icon
4. Click Duplicate at the bottom of the Edit window
5. Open the Select Classes menu, clear the check box next to
the currently selected class, and choose a different class
Click outside the Select Classes menu to close it.
6. Edit the duplicated assignment name by deleting the
underscore and number that were appended to the end
7. Use the same category, due date, score type, score entry
points, description, and publication settings as the original
assignment, or modify the values as needed
8. Click the Standards tab
9. Click Show All and, if needed, select a new set of
standards that are aligned to this assignment
10. To save the assignment and close the Edit window, click
Save and Close
11. To verify that you copied the assignment to a different
class, click the name of the currently selected class in the
navigation bar at the top of the page and select the class
that you copied the assignment to
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8. Under Choose the Assignments, check the box to the left of
the Category heading to select all of the assignments, or
check individual boxes next to the assignment names to
choose a smaller selection

12. Locate the duplicated assignment in the list of assignments

Copying Assignments
As a lead teacher or a co-teacher, copy one, some, or all of the
existing PowerTeacher Pro assignments in a selected term and
class to other terms and classes using the Copy Assignments
feature. Use the existing due dates, a custom due date, or
proportional due dates relative to the selected term. Also, copy all
of the assignments from a PowerTeacher Gradebook class to a
PowerTeacher Pro class.
If a lock icon appears at the top of the assignment column, the
reporting term or class is locked. You are unable to copy an
assignment to a locked term or class.
To copy assignments from a Semester 1 class to a Semester 2
class:
1. From the Assignments or Scoresheet pages, click the gear
icon to the left of the Term menu

If the source class you selected is a PowerTeacher
Gradebook class, all assignments will be copied to the
classes you select.
9. To complete the process, click Copy Assignments
Be sure to edit the due dates of the copied assignments.

Working with Grades
When entering scores, make sure to use the type of score that you
set up when you created the assignment. For example, use
numbers for points and percentages or letters for letter grades.
To enter scores:

2. Click Copy Assignments

1. Click Grading

3. Under From, open the Term menu and select Semester 1

2. Click Assignment List or Scoresheet

4. Under From, open the Class menu and select the class from
which you want to copy the assignments
5. Under To, open the Term menu and select Semester 2
6. Under To, open the Classes menu and select the class or
classes to which you want to copy the assignments
7. Under Copy Options, open the Due Dates menu and choose
whether you want to use existing, relational, or custom due
dates
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3. From the Assignments or Scoresheet pages, enter a
student’s assignment score by clicking in the cell where the
student’s name intersects with the assignment name and
type in the score
Navigate sideways through the score columns by clicking
the blue columns with left- or right-facing arrows at the end
of the rows.
View the summary above the list of assignments to see the
selected assignment’s score type, as well as the student’s
existing score (if the assignment was previously scored),
and the due date.

Your district leaders may have associated a special codes scale to
the regular grade scale. If that is the case, you can click Codes in
the Score Inspector and select a special code, such as NC for no
credit, to score a student’s assignment. In some cases, you may
also see other system-generated icons that are related to
standards grades.
To open the Score Inspector, click in a score cell on the
Assignments or Scoresheet pages.
The following table provides brief explanations of the flags (score
indicators) and other icons available in the gradebook.
Flag or Icon

In the summary, click Edit Assignment to edit the
assignment details. Click Show More to view additional
information, such as the associated grade and special codes
scales.

Description
Indicates that an assignment was collected

Indicates that an assignment is late
To view additional metrics for a selected assignment on the
Assignments page, or for all assignments on the Scoresheet page:
1. Click the gear icon at the top of the page

Indicates that an assignment is missing

2. Click Show Metrics to view the mean, median, and mode
statistics for the assignments or for the aligned standards

Using the Score Inspector and Flags

Indicates that an assignment is exempt

While you can enter scores manually, use the Score Inspector to
provide more details about the student’s performance, such as
when a student has a missing or late assignment. Also use the
Score Inspector to enter a comment about a student’s score.
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Flag or Icon

Description

Filling Scores

Indicates that an assignment wasn’t completed
due to the student being absent

Use the Fill functions to either fill scores for one assignment for all
of the students in a class, or to fill all assignment scores for one
student. Scores will be filled in cells that do not already have
scores. Additionally, use the fill scores functions to fill comments.

Indicates that an assignment is incomplete

To fill students’ scores for one assignment:
1. For the selected assignment, click in a score cell on the
Assignments or Scoresheet pages
2. Enter the score or select the flag in the Score Inspector

Indicates that a comment was added

3. Click the Fill icon with the vertical arrows
4. Save the scores
To fill multiple assignment scores for one student:

Indicates that evidence exists for mastery that
may differ from a student’s calculated standard
score

1. For the selected student, click in a score cell on the
Assignments or Scoresheet pages

Indicates that the standard grade is autocalculated from the lower-level standards scores

3. Click the Fill icon with the horizontal arrows

Indicates that the assignment score is used to
auto-calculate the scores for the standards
aligned to the assignment

2. Enter the score or select the flag in the Score Inspector
4. Save the scores

Importing Personal Comments from
PowerTeacher Gradebook
If you used PowerTeacher Gradebook previously, import your
personal comments to PowerTeacher Pro so that you don't have to
create them manually. Keep in mind that you can import
comments only once and only until you create your first
PowerTeacher Pro comment.
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If you have already created PowerTeacher Pro comments but would
like to import your PowerTeacher Gradebook comments, delete the
comments you created in PowerTeacher Pro to view the import
option again.

10. On the My Comments tab, click Add
11. Enter a comment code, such as 01
Comment codes are limited to 10 characters.

To initiate the import, first click Settings. Then click Comment
Bank. On the Comment Bank page, click Import my PTG
Comments. PowerTeacher Pro comment codes are limited to 10
characters, comment categories are limited to 30 characters, and
the comments are limited to 500 characters. Any PowerTeacher
Gradebook comment exceeding these limitations will be truncated
during the import. If any of your PTG comments exceed the
limitations, you will see a warning. Click Yes to proceed. Once the
import is complete, your personal comments appear on the My
Comments tab of the Comment Bank settings page and are
available for use in the Score Inspector.

12. Enter a comment category, such as Study Habits
Comment categories are limited to 30 characters.
13. To mark this comment as one of your favorites, check
Favorite
14. Open the Insert Smart Text menu and choose <first
name> to insert it in the Comment field
15. Enter the rest of the comment after the smart text, such as
consistently completes homework on time

Adding Personal Comments to the Comment
Bank
Use the Comment Bank settings page to add personal (teachercreated) comments to the comment bank to use when scoring
assignments or adding final grade comments for report cards. Use
smart text options to include names and pronouns in comments to
personalize the comments for individual students.
Also use the Comment Bank settings page to edit or delete
personal comments, or to identify your favorite personal or district
comments. To mark a comment as a favorite, click the star next to
a comment on either the My Comments or District Comments tab.
Your favorite comments will appear at the top of the list of
comments in the Score Inspector.
To add a personal comment to the comment bank:
8. Click Settings

Comments are limited to 500 characters.
16. Click Save
Your personal comment is listed on the Comment Bank
setting page and will appear in the comment bank in the
Score Inspector.

Entering Comments
As you enter scores or flags for assignments, use comments to
record specific details about student performance. Add comments
manually or choose comments from the comment bank. Click the
star next to a comment in the bank to set it as one of your favorite
comments.
To fill comments, enter a comment for one student and click the
Fill icon. Then choose to fill comments only or to fill scores, flags,
and comments.

9. Click Comment Bank
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When you use the fill functions to fill comments that include the
student’s name or any gender pronouns, PowerTeacher Pro detects
this and you have the choice of applying the smart text to the
comment for each student or using the original text. For example,
if you enter a comment for one student that says, “James
completed all assignment tasks,” fill the comment for other
students, and select Use Smart Text, each student’s name will be
personalized in the resulting comments.

Scoring Assignments
Use one of two methods to score an assignment—score a single
assignment from the Assignments page, or score multiple
assignments on the Scoresheet.
To enter scores, flags, or comments for a single assignment:
1. Click Grading

To enter a comment:

2. Select Assignment List

1. Click the Comment icon in the Score Inspector

3. Click the name of an assignment

2. Either enter a comment in the text box, or click Show
Comment Bank

4. Click in a student’s score cell and type a score, such as 72
View the assignment summary above the list of students to
see which score type to use.

3. Click the gear icon and choose either the District Comments
or My Comments bank

5. Click the Comment icon in the Score Inspector
Also choose to separate comments by a line break or a
space. Click outside of the menu to close it.

6. Enter a comment, such as Needs to turn work in on
time

4. Click the + sign next to a comment to select it

7. Click the right-facing Score arrow in the Score Inspector to
move to a standards score cell (if standards are aligned to
the assignment)

A blue Comment icon appears in the student’s score cell.
5. Click Save

8. Enter a standards score for the student

6. Click the icon to read the comment

View the assignment summary above the list of students to
see which grade scale type to use. Hover your cursor over a
standard identifier to view the name and description of the
standard.

7. Click Clear Comment to remove it from the score

9. Save the scores
To enter scores, flags, or comments for one or more assignments
on the Scoresheet:
1. Click Grading
2. Select Scoresheet
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3. Click in a student’s blank score cell for the selected
assignment and enter a score in the Score Inspector
4. Click the vertical Fill icon to fill all of the blank score cells
with the score you entered in the Score Inspector
5. In the alert window that lists the number of scores that
were filled, click Ok
6. Click in a different student’s score cell for a different
assignment and click the Exempt flag
7. Click Save
When you delete or edit a score, a small gear icon appears next to
the values in the student’s Grade column because they are being
edited. Once you save the changes, the student’s grades will be
recalculated using the new score.

•

If the list of students is different between the original
assignment scores and the assignment being copied to, only
scores for students who are in both classes will be updated

•

You cannot paste into the assignment score column on the
single assignment scoring page when an assignment is set
to auto calculate standard scores

•

You are unable to copy scores and grades to a locked term

1. On the Assignments, Scoresheet, or Standards Grades
pages, click the assignment score column heading
2. Choose Copy
3. Locate the assignment you wish to paste to and click the
score column header

As a busy teacher, you can sometimes make mistakes like entering
scores for the wrong assignment in your gradebook. Or, you may
have students switch between two classes that you teach.

4. Then choose Paste
All updated scores and grades are highlighted.

Copying and Pasting Scores

•

When pasted to a column with different grade scales or total
points, scores and grades are not converted to the new
grade scales or total points

To copy and paste scores or grades:

Copying and Transferring Scores

Fix score entry mistakes or transfer scores by copying and pasting
scores or grades from one assignment to another, or from one
class to another class with the same students in different reporting
terms. Use the Assignments, Scoresheet, or Standards Grades
pages to copy and paste scores or grades. However, keep the
following rules in mind:

•

5. Save the scores

Transferring Scores
When a student transfers into your class or moves between two
sections of a class you teach after the term has started, you can
copy the assignment scores from the student's dropped class into
the new class. However, keep the following rules in mind:

You cannot replace scores or grades that use a different
score type than the original
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•

Only assignments with scores for the selected student in the
dropped class are available to be transferred
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•

Assignment scores, standards scores, assignment
comments, and assignment flags are saved as part of the
transfer process

•

Comments from the teacher who taught the dropped class
will be listed with that teacher's name at the end of the
comment

•

When transferring scores to an assignment using a different
grade scale, percentages are copied, points are adjusted as
needed, and letter grades are calculated based on the grade
scale used by the student's new class

•

Scores from any term can be copied, even if the previous
term is locked

•

Scores can be copied to any term, except to a locked term

7. Use the To Class Assignment column to map the
assignments
If the assignment ID or assignment name matches between
the From Class and To Class columns, the matching
assignment appears in the To Class column automatically.
If there are multiple assignment names that match between
the From Class and To Class columns, but there is one
unique due date match among the multiple exact name
matches, the assignment with the matching due date
appears in the To Class column automatically.
If there are no matching IDs or names between the From
Class and To Class columns, then no suggested assignment
appears, but you can browse available assignments and
select one to map the scores to.

To transfer assignment scores from a student's dropped class:
1. Click Students

8. To view the details and any potential issues about the
scores you are transferring, click Details

2. Select the student who transferred into your class
Students who enrolled in the class after the term's start
date are labeled with "New student as of [date]" under their
names. The label will be present for only two weeks from
the student's class enrollment date.
3. Open the Quick Menu and select Transfer Scores
If you are viewing the student's Assignments page, click the
gear icon and choose Transfer Scores.
4. To use the filter options to limit the number of assignments
that appear on the page, click the gear icon, select Show
Filter, and use the filter options

9. To complete the process, click Transfer Scores

Exporting and Importing Assignment Scores
When you need to score an assignment offline, such as when you
have a parent volunteer score an assignment, export the
assignment into a spreadsheet. Then record the students' scores in
the spreadsheet and use it to import the scores into PowerTeacher
Pro. If the reporting term or class is locked, you are unable to
import scores.
To export and import assignment scores:

5. Open the From Class menu and select the dropped class
6. Open the To Class menu and select the class you want to
copy the scores to
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1. Click Grading
2. Select Assignment List
3. Click the name of the assignment
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4. In the upper-right corner of the assignment page, click the
gear icon
5. Select Export Scores Template
If there are any existing assignment scores, choose whether
or not to include the scores in the exported file by clicking
Yes or No in the Export Scores Template window.
6. Open the exported file
The top of the spreadsheet includes the teacher's name,
class, assignment name, due date, points possible, extra
points, and score type. Below the assignment details are
three columns—Student Number, Student Name, and Score.
7. Enter the students' scores in the Score column and save the
spreadsheet as a .csv file

Working with Final Grades
Final grades are updated automatically throughout the term as you
enter assignment scores in the gradebook. When the term comes
to a close, however, you may have additional tasks to perform
before submitting grades for report cards to make sure that your
final grades are accurate. For example, you may have to enter
standards grades, modify individual scores, or enter citizenship
grades. Occasionally, you may also need to modify a student’s final
grade in a course based on effort, participation, or other
performance factors.
To work with final grades, click Grading and use the links in the
Grades section. Access the same links through the Quick Menu—
the arrow next to the heading at the top of the grading pages.

8. In PowerTeacher Pro, navigate back to the assignment
page, click the gear icon, and select Import Scores
9. In the Import Scores window, click Browse Files
10. Select the spreadsheet file
11. In the Format menu, use the default selection of
PowerTeacher Score Template
12. Check Validate Student Names to verify that the student
names in the import file match the names of the students
enrolled in the class

To modify a final grade:

13. Click Next
Review and correct any import errors.
14. To import and save the scores in PowerTeacher Pro, click
Import
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1. Click Grading
2. Click Traditional
3. Click a student’s final grade
4. In the Score Inspector, edit the student’s grade
For example, change a letter grade of A- to A, and a
percentage of 91 to 94.
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5. Click Save
Notice that the student’s final grade cell has a small triangle
in the upper-left corner, which indicates that the grade has
been modified manually.

Viewing Dropped Students
When working with final grades, if you need to view, modify the
final grades for, or enter comments about the students who have
dropped your class, do so from the Traditional grades page.
To view dropped students:
1. Select the class the student was in

6. Open the Quick Menu and select Standards

2. Click Grading

7. Click a standards grade for the same student

3. Click Traditional

8. In the Score Inspector, click the graph icon to open the
view-only standards progress graph for the selected
standard and student

4. Click the gear icon and select Show Dropped Students

The progress graph shows how the student performed on
the standard over a period of time. Use the arrows in the
Score Inspector to move between progress graphs for the
selected student. To open the student's Standards Progress
page to change assignment scores, you could click Show
More at the top of the graph. Learn more about the
Standards Progress page in the Analyzing Performance
section of this document.

Entering Citizenship Scores
If your school doesn't track behavior through standards, then your
district leaders may enable citizenship score entry and set up a
citizenship scale that includes codes like S for Satisfactory or N for
Needs Improvement for you to use in PowerTeacher Pro.
To enter citizenship scores:

9. Click the graph icon in the Score Inspector again to close
the progress graph
10. On the Standards page, edit the student's final standards
grade

1. Click Grading
2. Click Traditional
3. Click in a student's cell in the Citizenship column
4. In the Score Inspector, select a citizenship score, such as S
5. Click Save

For example, change a score of 3 to 4 or a score of M to E.
11. Click Save
To revert to the calculated grade, click the Undo icon in the
Score Inspector. To view additional standards metrics, click
the gear icon at the top of the page and then select Show
Metrics to view the mean, median, and mode statistics.
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Awarding Variable Credit
If you teach at a school that has an alternative education program
or any sections in which students can earn variable credit hours for
a course, your school administrator can set up PowerSchool SIS so
that you can enter variable credit for students in PowerTeacher
Pro.
Using variable credit, teachers can specify how much credit each
student attempted (potential credit) and how much credit each
student is awarded (earned credit), regardless of the credit hours
specified for the course or the grade the student earned for the
class in a term.
To enter awarded and attempted variable credit:

Recalculating Assignment Scores and Final
Grades
Although grades in PowerTeacher Pro are calculated automatically,
you can force a recalculation, if necessary. Use the recalculate tool
after making significant changes in the gradebook, such as adding
multiple assignment scores for students who transferred from
another class. Also, recalculate scores and grades when your
PowerSchool SIS administrator changes a setting that affects the
gradebook, such as the grade calculation formula or grade scale, or
when you assign an alternate grade scale to a student.
To use the recalculate tool:

1. Click Grading
2. Click Traditional
3. Click in a student's cell in the Awarded column
4. Enter the number of credits the student earned, such as .5
5. Click in the same student's cell in the Attempted column
6. Enter the number of credits the student attempted,
such as 1
7. Click Save
Note: If your school's transcripts include only awarded credit, then
you'll see only one column for entering the credit values in
PowerTeacher Pro.

1. Click Grading
2. Select Traditional
Or select Scoresheet, Standards, Comment Verification,
Category Totals, or All Reporting Terms under Grading.
Under Students, click Assignments, Standards Progress, or
Comment Log.
3. Click the gear icon
4. Select Recalculate Final Grades
5. Select the classes in which you are recalculating grades
6. To recalculate traditional grades, check Traditional Final
Grades
7. To recalculate standards scores, check Standards Final
Grades
8. To update existing assignment scores, open the Advanced
Options pane and check Refresh Assignment Scores
Recalculate assignment scores only when your PowerSchool
SIS administrator changes the grade scale.
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9. Click Recalculate

Submitting Final Grades
At the end of the term, notify your school’s PowerSchool SIS
administrator that you have finished entering the scores for the
term and that final grades are ready to be stored.
1. Select a class and verify that you are in the correct term
2. Click Grading
3. Select Traditional
Or select Standards or Comment Verification.
4. At the bottom of the page, click Final Grade Status
5. When you have completed your final grades, check [Term]
Final Grades are Complete

Understanding Locked Reporting Terms
At the end of a reporting term, your PowerSchool SIS administrator
may choose to lock the reporting term to prevent changes to
grades so that the grades in teachers' gradebooks remain the same
as the grades that have been stored in PowerSchool SIS and
included on report cards. Your PowerSchool SIS administrator will
define the dates on which reporting terms will be locked. Once a
reporting term is locked, you will not be able to change final
grades, assignment scores, or assignments that have been scored.
Additionally, if you recalculate final grades, grades in any locked
terms will not be recalculated.
If your school or district leaders decide to lock reporting terms, you
will see warning messages at the top of PowerTeacher Pro pages,
such as the Assignments and Scoresheet pages.
•

6. Enter a comment indicating that final grades are complete,
and click Save

For example, you may see a message that says the
reporting term will be locked in five days. Be sure to
complete final grades before the end of the lock date.

The green check mark next to "Final Grade Status" indicates
that final grades are complete.

If you aren’t done with final grades yet, leave the check box
clear, enter a status comment, and click Save. Remember
to submit final grades for each class you teach.

Before the reporting term is locked, you will see a warning
message indicating when the reporting term will be locked

•

Once a reporting term has been locked, you will see a
message indicating that the term is locked

If you attempt to score an assignment or a standard aligned to an
assignment that has a due date in a locked term, you will also see
a message in the Score Inspector indicating that the score is
locked.
What if you need to correct a final grade after a term is locked? If
you need to change assignment scores or final grades after a
reporting term has been locked, contact your PowerSchool SIS
administrator. Your administrator can temporarily unlock one or
more of your classes so that you can make the necessary changes.
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Analyzing Performance
Use the gradebook to analyze student performance at any time
during the school year. Analyze performance throughout the term
to ensure that students are mastering the skills and standards that
you are teaching. Review students’ performance as you prepare to
complete final grades for report cards, and then use the gradebook
to prepare for and conduct parent-teacher conferences.

Student
View Page

The Standards Scoresheet is similar to the Student
View in PowerTeacher Gradebook.
Transfer
Scores

Use the Transfer Scores page to copy the
assignment scores from a student's dropped class
into a new class when that student transfers into
your class or moves between two sections of a
class you teach after the term has started. Use the
Transfer Scores page to copy scores from any
term, even if the previous term is locked. Copy
scores to any term, except to a locked term.

Comment Log

Use the Comment Log page to view all of the
comments you’ve recorded for a student.
Depending on the types of comments you’ve
entered for the student, the comment log may
show course grade comments, standards grades
comments, and assignment comments.

Demographics

Use the Demographics page to view a student’s
personal information, such as his date of birth or
mother’s phone number. Administrators may
choose to set up PowerSchool SIS so that you can
see the contact information from any student
contacts associated with the selected student.

Review how students in an entire class are performing using the
Progress pages. The individual student pages provide helpful
information during parent-teacher conferences to explain why a
student earned a particular grade.
Student
View Page

Description

Assignments

Use the Assignments page to view a summary of a
student’s grades and assignments for the selected
reporting term. The Assignments student page is
similar to the Assignments page you view for the
entire class, except that it shows only the
assignments and scores for the selected student.

Standards
Progress

Standards
Scoresheet

Description

The Standards Progress page shows a student’s
standards grades by reporting term. The column
that corresponds to the current term is
highlighted. Compare the grades the student
received in each term to assess his or her
progress. To view the assignments that you used
to assess the standard, click the icon in the
Assignments column. Then use the graph at the
top of the page to see how the student performed
over time on the standard.
Use the Standards Scoresheet to view a student's
standards scores on all of the standards aligned to
assignments for a reporting term on a single page.
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Regardless of the district setting, some student
contact data will be available in PowerTeacher Pro
if the district has enabled the student contacts
feature. This includes email addresses, phone
numbers, employers, and original contact types, if
set. Your administrators can enable other contact
information.
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Student
View Page

Description

Quick Lookup
- Traditional

The traditional Quick Lookup page is the same
page that administrators see in PowerSchool SIS.
It shows the student’s attendance for the last two
weeks, his current schedule, his term grades, a
summary of his total absences and tardies, and his
current GPA. Click a grade to see the flags (colored
icons or indicators that represent common
assignment notes like “Late” and “Missing”) for the
student’s assignments and to see the standards
score information. Click the Standards icon to view
the standards aligned to an assignment. Parents,
students, and administrators will also see this
information for all PowerTeacher Pro sections.

Viewing Individual Student Progress
To review an individual student’s performance:

Quick Lookup
- Standards

To view a student’s standards Quick Lookup page,
use the Quick Lookup - Standards link. Then click
the arrow next to one of the student’s classes to
view the standards aligned to the course and the
student’s standards final grades. Click a standard
final grade to view details about it. When a student
is graded on the same standard in multiple classes,
the student's final grades on that standard can be
averaged into one final grade—view the standard
grade rollup information on this page.

PowerTeacher
Portal

Use the PowerTeacher Portal link to view the
selected student’s screens in PowerTeacher.
PowerTeacher opens in a new window so that you
don’t lose your place in PowerTeacher Pro. The
PowerTeacher screen that appears depends on
which screen you set up to be the default student
screen in PowerTeacher. For example, you may
see the student’s Schedule screen.

Copyright © 2020 PowerSchool Group, LLC or its affiliates. All rights reserved.

1. At the top of the gradebook window, select a class
2. Click Students
3. To view the first student’s performance, click Assignments
4. Review the student’s course grades and individual
assignment scores, then open the Quick Menu and select
Standards Progress
5. Review the student’s standards scores for each reporting
term, then click the Assignments icon for one of the
standards
6. Review the graph of standards scores, then click Show
Metrics to review the student’s other standards statistics

7. Click Students and select a different student to view his or
her Standards Progress page
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As outlined in the "Working with Final Grades" section of this
document, you can also view a student's Standards Progress
graphs directly from the Standards page by clicking a student's
standards grade, and then clicking the graph icon in the Score
Inspector. Using the Standards page to view progress graphs is
useful when preparing for report cards.
Here are the definitions of the standards scores statistics that are
visible when you click Show Metrics below the graph:

Use your professional judgment to evaluate whether or not the
calculated score is a true indication of the student’s level of
mastery. For example, if the student was ill or had a bad test day,
his last score may not be a true indicator of his skill level, so you
could choose to ignore that score and change the calculated score
from a 2- to a 2.

•

Most Recent – The average of the most recent score(s)

•

Mean – The mathematical average of the scores

•

Median – The middle of the scores (half of the scores are
above this number and half are below)

•

Mode – The most common score achieved

Graphing Additional Standards or Metrics

•

Weighted Mean – The average of the scores based on the
average of total weighted points

To compare a student’s progress on up to four standards:

•

Highest – The highest score

These statistical values are indicators of how well the student did
on a specific standard. If any of the values are low, it may mean
that the student needs additional practice on the skill or concept
that you’re assessing, or you may need to revise the assignment.
To view the student’s performance on additional standards, open
the Quick Menu and select a standard.
The orange Professional Judgment Indicator may appear next to a
student’s standard score on the Standards Progress page when
evidence exists for mastery that may differ from the student’s
calculated standard score. To evaluate the student’s level of
mastery, click the Assignments icon next to the standard score.
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1. Click the gear icon next to the term menu on the Standards
Progress page
2. Click Progress Options
3. In the Progress Options window, select the standards you
want to include in the comparison and click OK
4. Then, click the Show/Hide Graphs icon next to the gear icon
to view the student’s progress on all of the selected
standards
5. Click one of the symbols, such as a triangle, on one of the
line graphs for a different standard to highlight it and view
the scores
6. Below the graph, view the calculated standard grades, the
metrics, the aligned assignments, and the scores for the
standards included in the comparison
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Analyzing Class Progress

By default, the Standards Progress graph displays a green dotted
line that corresponds to the metric, such as Most Recent, used in
the standards grade calculation.

To analyze the performance of an entire class, begin by selecting
the class at the top of the gradebook window. Then, click
Progress. Depending on how the gradebook is set up, you can
view class progress on traditional grades and standards grades.

To add additional metrics to the graph:
1. Click the gear icon next to the term menu on the Standards
Progress page
2. Click Progress Options
3. In the Progress Options window, open the "Additional Metric
To Graph" menu and select a metric, such as Highest
4. Click OK
A gray dotted line appears on the graph, indicating the
score that corresponds to the selected metric.
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Viewing Traditional Grades Progress
To view traditional grades progress:
1. From the Progress menu, select Traditional
The graph on the Traditional Grades Progress page shows
the distribution of grades for the class for the selected
reporting term. The horizontal black line shows where the
cutoff is between passing and failing grades. Click the
information (i) icon to view the traditional grades included
in each color level. To the right of the graph, view a
summary of the total number of students who have missing,
late, or incomplete assignments.

4. On the right, view the grade trends of the students in the
class for the selected term, compared to the previous term
A red arrow in the Grade column indicates that the student’s
grade is trending down between the selected terms. A green
arrow indicates an upward trend, while no arrow indicates
no change. You can see which students are performing
better or worse between terms.
5. To compare trends between a different selection of
subsequent terms, click a term in the Grade Distribution
column
6. Click the information (i) icon to view the grades included in
each color level
7. To close the window, click X in the upper-right corner

2. Click View All to open the Traditional Grades Distribution
window
3. On the left side of the Traditional Grades Distribution
window, view the grade distribution for each reporting term
in the school year
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5. To compare trends between a different selection of
subsequent terms, click a term in the Grade Distribution
column

Viewing Standards Grades Progress
To view standards grades progress:
1. From the Progress menu, select Standards

6. To close the window, click X in the upper-right corner

The graph on the Standards Progress page shows the
distribution of grades for each standard aligned to the
course, for the selected class and reporting term. The black
line shows where the cutoff is between passing and failing
grades

2. Click the graph to open the Standard Grades Distribution
window
3. On the left side of the Standard Grades Distribution window,
view the grade distribution for the selected standard for
each reporting term in the school year
4. On the right, view the grade trends of the students in the
class for the selected term, compared to the previous term

On the right side of the Standards Progress page, the number in
the Assignments column indicates the number of assignments that
you’ve used to give students opportunities to practice the standard
or to assess their levels of mastery.

A red arrow in the Grade column indicates that the student’s
level of mastery is trending down between the selected
terms. A green arrow indicates an upward trend, while no
arrow indicates no change.
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To view the assignments aligned to a standard:
1. Click the Assignments icon next to a standard

Report Name
Individual Student
Report

2. On the Standards Assignment Trend window, click the name
of an assignment

Description
•

Use this report to view or print a
summary of the class activity per
student

•

Include only one class or the
student's full schedule

•

Generate a report similar to the
Multi-Section Report in
PowerTeacher Gradebook that
includes scores for any course a
student or a whole class is taking

•

Include student numbers next to
student names for identification
purposes

•

Present a summary of student
work to parents at conferences or
to a principal during a review, or
use the report as a midterm
update for students and parents

•

Choose whether or not to include
course grades and attendance,
assignments, category totals,
standards scores, citizenship
scores, and comments

•

Print the report for a few students
or a group

3. If needed, edit students’ scores in the column for the
selected standard and save the scores

Running PowerTeacher Pro Reports
The gradebook contains reports that you can view onscreen or
print. Personalize each report by entering a custom title or by
including a top note, bottom note, or signature line. The following
table provides brief descriptions of the reports:
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Report Name
Multi-Function
Assignment Report

Scoresheet Report

Description
•

Use this report to view or print a
list of students and scores per
assignment

•

Use it to find missing, late, or
incomplete assignments, to help
students and parents keep up with
class work, to target students who
need extra help, or to gauge
which assignments present the
most challenges to students

Report Name
Student Roster

Description
•

Use this report to view or print
demographic information by class

•

Use the report, for example, to
keep track of money collected for
classroom field trips, or as an
emergency contact list

•

Customize the report by adding
blank columns (the report
remembers the information you
entered last)

•

Use this report to print a copy of
the Scoresheet page

•

Use the Order arrows to arrange
the columns in any order

•

Include final grades and
assignment scores

•

Run the report as a PDF or an
Excel spreadsheet

•

Use student numbers or names

•

Sort students by name, student
number, or randomly

•

Use it to post a printout of
students' grades

•

Run the report as a PDF or an
Excel spreadsheet

Using the Report Queue
Navigate to the Report Queue to view reports you've generated.
Access the Report Queue by either clicking Reports in the
navigation menu and selecting Report Queue or clicking the
Notification icon and selecting Report Queue.
Reports in the queue are listed by name and date. View the icons
in the Status column to see if a report is running, pending,
completed, cancelled, or if there was an error. Refer to the legend
for icon definitions.
To download and view a report, click the report name. To delete a
report, click the trash can icon in the Actions column. To rerun a
report using the same settings you used to run the original version,
click the Information (i) icon in the Actions column, then click
Resubmit. To update the status of a running or pending report,
click Refresh.
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8. To sort the report by students’ last names, open the
Students menu and choose Last Name
To use the preference for how student names are sorted by
default in your gradebook that you defined under Settings >
Display Settings, choose Gradebook Preference.
9. Use the Assignments menu to sort the assignments by due
date or by category and due date
To run the Individual Student Report:
1. Click Reports
2. Select Individual Student Report
3. Enter a report title, such as Progress Report
4. Open the Select Classes menu and choose the classes to
include on the report
5. To use a previously customized class name, check Use
Custom Class Name
6. Since you are creating a progress report that includes
students' course grades in only your class instead of all of
their classes, leave the "Include Students' Full Schedules"
check box clear
Check Include Students' Full Schedules to create a
multi-section report that includes scores for any class the
student is taking.
7. In the Sort Options section, open the Layout menu and
choose By Section, By Student

10. Open the Areas To Include menu and check Course Grade
Comments and Assignment Comments to include any
comments that you’ve entered about the students in the
report
"Course Grades and Attendance," Assignments, and
Category Totals are checked by default. If citizenship score
entry is enabled, select Citizenship to include citizenship
scores.
11. Click the Areas To Include menu again to close it
12. Verify that Show Percentages is selected to include
students’ grade percentages in the report
13. To help with identifying students with the same name, add
student numbers to the report by selecting Include
Student Number with Student Name
14. To include students’ grades from the current term, use the
default settings under Date Range
15. Use the default settings under Data Filters to include any
assignments, any scores, any category, and any course
grades
16. Open the Students tab
17. To run the report for a selection of students rather than for
all of the students in the classes, click Add/Remove
Students
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18. All of the students are selected by default, so clear the
check box to the right of the Filter area, then in the list of
students, check the boxes next to individual student’s
names

30. To download the completed report, click the report name

19. Scroll to the top of the page and click the Format tab
20. Since you are including all of the available data in the
report, leave the page orientation set to Landscape to
make the text easier to read
21. Use the default option PDF for the report output
22. To create a page break between students, check Page
Break
23. Choose to exclude row shading to save ink during printing

To run the Student Roster report for a class:

24. Leave the “Include” check box clear for the Top Note option,
since you don’t plan to include a note at the top of the
report

1. Open the menu at the top of the gradebook window and
select a class
2. Click Reports

25. Leave the “Include” check box clear for the Bottom Note
option, since you don’t plan to include a note at the bottom
of the report

3. Select Student Roster

26. Clear the Signature Line check box, since you don’t need
parents to sign the report

5. Since you selected a class before you navigated to the
Reports menu, it is already selected for the Classes option

27. To generate the report, click Run Report

6. To sort the roster of students by last name, open the
Students menu and choose Last Name

An alert at the top of the window indicates that the report is
being processed.
28. To open the Report Queue, click View Reports
Or, click the Notification icon—which has a red number
indicating the number of reports that are ready—and then
select Report Queue.
29. If the report is still running, click Refresh to update the
status
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4. Enter a report title, such as Field Trip Roster

7. Add columns of student information by opening the Add
Columns menu next to Student Columns and clicking Add
next to Gender and Grade Level
8. Click Add next to Blank twice to include a column for taking
attendance and one for tracking participation
A column titled “Name” is included by default to list the
students’ names.
9. Click the Add Columns menu again to close it

30

PowerSchool SIS: PowerTeacher Pro
Quick Reference Card
10. Enter Attendance as the title of the first blank column

23. To download the completed report, click the report name

11. Enter Participation as the title of the second blank
column
12. Add columns of contact information by opening the Add
Columns menu next to Contact Columns and clicking Add
next to Contact Name and Contact Phone
Note that the contact options are determined by the districtlevel settings.
13. Click the Add Columns menu again to close it
14. Open the Filter Contacts menu and select the contact type,
if desired
15. Click the Students tab at the top of the page and verify that
the report applies to all of the students in the selected class
16. Scroll to the top of the page and click the Format tab
17. Open the Orientation menu and choose Portrait
18. Use the default option PDF for the report output
To work with the data in a spreadsheet, choose Excel.
19. Use the default settings for the rest of the format options
20. To generate the report, click Run Report
An alert at the top of the window indicates that the report is
being processed.
21. To open the Report Queue, click View Reports
22. If the report is still running, click Refresh to update the
status
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